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1. Перечень планируемых результатов обучения по дисциплине, соотнесенных с 

установленными в образовательной программе индикаторами достижения 

компетенций 

 

По итогам освоения дисциплины обучающийся должен достичь следующих результатов 

обучения: 

Категория 

(группа) 

компетенций 

(при наличии 

ОПК) 

Формируемая 

компетенция (с 

указанием кода) 

Код и наименование 

индикатора 

достижения 

компетенции 

Результаты обучения по 

дисциплине 
 

- ПК-4 - готовностью 

осуществлять получение 

оперативной 

гидрометеорологической 

информации и ее 

первичную обработку, 

обобщение архивных 

гидрометеорологических 

данных с использованием 

современных методов 

анализа, программных 

средств и 

геоинформационных 

систем 

ИПК - 4.1. Производит 

сбор и  хранение 

оперативной  

гидрометеорологической 

информации 

Знать: 

Основные принципы работы в 

различных программных 

комплексах данного направления, 

умение решать другие задачи при 

помощи этого направления 

ИПК – 4.2. Применяет 

современные 

информационные 

ресурсы для обработки 

гидрометеорологической 

информации 

Уметь: 

Применять свои знания при работе 

со смежным оборудованием и 

программным обеспечение для 

комплексного подхода к решению 

задач данного направления 

Владеть: 

навыками работы с программным 

обеспечением на ПК 

 

2. Цель и место дисциплины в структуре образовательной программы 

 

Дисциплина «Специализированный ГИС практикум по гидрометеорологии» относится 

к части, формируемой участниками образовательных отношений. 

Дисциплина изучается на 2 и 3 курсах в 4,5 семестрах.. 

Цели изучения дисциплины: является в том, чтобы, дать возможность, изучить 

реальные функции и потенциальные возможности ГИС-технологий для решения 

гидрометеорологических задач.       

 

3. Содержание рабочей программы (объем дисциплины, типы и виды учебных занятий, 

учебно-методическое обеспечение самостоятельной работы обучающихся) 

 

Содержание рабочей программы представлено в Приложении № 1. 

 

 

4. Фонд оценочных средств по дисциплине 

 

4.1. Перечень компетенций и индикаторов достижения компетенций с указанием 

соотнесенных с ними запланированных результатов обучения по дисциплине. 

Описание критериев и шкал оценивания результатов обучения по дисциплине. 

 

 

1 семестр  

 

Код и формулировка компетенции: ПК-4 - готовностью осуществлять получение 

оперативной гидрометеорологической информации и ее первичную обработку, обобщение 

архивных гидрометеорологических данных с использованием современных методов анализа, 

программных средств и геоинформационных систем 



  

Код и наименование 

индикатора достижения 

компетенции  

Результаты обучения по 

дисциплине 
Критерии оценивания результатов 

обучения 
«Не зачтено» «Зачтено» 

ИПК - 4.1. Производит 

сбор и  хранение 

оперативной  

гидрометеорологической 

информации 

Знать: 

Основные принципы работы в 

различных программных 

комплексах данного направления, 

умение решать другие задачи 

при помощи этого направления 

Объем знаний 

оценивается на 59 и 

ниже баллов от 

требуемых 

Объем знаний 

оценивается от 60 до 

110 баллов от 

требуемых 

ИПК – 4.2. Применяет 

современные 

информационные ресурсы 

для обработки 

гидрометеорологической 

информации 

Уметь: 

Применять свои знания при 

работе со смежным 

оборудованием и программным 

обеспечение для комплексного 

подхода к решению задач данного 

направления 

Объем умений 

оценивается на 59 и 

ниже баллов от 

требуемых 

Объем умений 

оценивается от 60 до 

110 баллов от 

требуемых 

Владеть: 

навыками работы с 

программным обеспечением на 

ПК 

Объем умений 

оценивается на 59 и 

ниже баллов от 

требуемых 

Объем умений 

оценивается от 60 до 

110 баллов от 

требуемых 

 

2 семестр  

 

Код и формулировка компетенции: ПК-4 - готовностью осуществлять получение 

оперативной гидрометеорологической информации и ее первичную обработку, обобщение 

архивных гидрометеорологических данных с использованием современных методов анализа, 

программных средств и геоинформационных систем 
Код и 

наименование 

индикатора 

достижения 

компетенции  

Результаты 

обучения по 

дисциплине 

Критерии оценивания результатов обучения 
2  

(«Не 

удовлетворит

ельно») 

3 

(«Удовлетвор

ительно») 

4  

(«Хорошо») 

5 

(«Отлично») 

ИПК - 4.1. 

Производит 

сбор и  

хранение 

оперативной  

гидрометеоро

логической 

информации 

Знать: 

Основные принципы 

работы в различных 

программных 

комплексах данного 

направления, умение 

решать другие задачи 

при помощи этого 

направления 

Объем знаний 

оценивается 

на 45 и ниже 

баллов от 

требуемых 

Объем знаний 

оценивается от 

45 до 59 

баллов от 

требуемых 

Объем знаний 

оценивается от 

60 до 79 

баллов от 

требуемых 

Объем знаний 

оценивается от 

80 до 110 

баллов от 

требуемых 

ИПК – 4.2. 

Применяет 

современные 

информационн

ые ресурсы 

для обработки 

гидрометеоро

логической 

информации 

Уметь: 

Применять свои знания 

при работе со 

смежным 

оборудованием и 

программным 

обеспечение для 

комплексного подхода к 

решению задач данного 

направления 

Объем умений 

оценивается 

на 45 и ниже 

баллов от 

требуемых 

Объем умений 

оценивается от 

45 до 59 

баллов от 

требуемых 

Объем умений 

оценивается от 

60 до 79 

баллов от 

требуемых 

Объем умений 

оценивается от 

80 до 110 

баллов от 

требуемых 

Владеть: 

навыками работы с 

программным 

обеспечением на ПК 

 

4.2. Типовые контрольные задания или иные материалы, необходимые для оценивания 

результатов обучения по дисциплине, соотнесенных с установленными в 

образовательной программе индикаторами достижения компетенций. Методические 

материалы, определяющие процедуры оценивания результатов обучения по 

дисциплине. 



  

 

1 семестр  

Код и наименование 

индикатора достижения 

компетенции 

Результаты обучения по 

дисциплине 
Оценочные средства 

ИПК - 4.1. Производит сбор 

и  хранение оперативной  

гидрометеорологической 

информации 

 

Знать: 

Основные принципы работы в различных 

программных комплексах данного 

направления, умение решать другие 

задачи при помощи этого направления 

Лабораторные работы 

Контрольные работы  

Зачет 

ИПК – 4.2. Применяет 

современные 

информационные ресурсы 

для обработки 

гидрометеорологической 

информации 

Уметь: 

Применять свои знания при работе со 

смежным оборудованием и программным 

обеспечение для комплексного подхода к 

решению задач данного направления 

Лабораторные работы 

Контрольные работы  

Зачет 

Владеть: 

навыками работы с программным 

обеспечением на ПК 

Лабораторные работы 

Контрольные работы  

Зачет 

 

Критериями оценивания при модульно-рейтинговой системе являются баллы, 

которые выставляются преподавателем за виды деятельности (оценочные средства) по 

итогам изучения модулей (разделов дисциплины), перечисленных в рейтинг-плане 

дисциплины (для зачета: текущий контроль – максимум 50 баллов; рубежный контроль – 

максимум 50 баллов, поощрительные баллы – максимум 10). 

Шкалы оценивания:  

для зачета: 

зачтено – от 60 до 110 рейтинговых баллов (включая 10 поощрительных баллов), 

не зачтено – от 0 до 59 рейтинговых баллов). 

 

2 семестр  

Код и наименование 

индикатора достижения 

компетенции 

Результаты обучения по 

дисциплине 
Оценочные средства 

ИПК - 4.1. Производит сбор 

и  хранение оперативной  

гидрометеорологической 

информации 

 

Знать: 

Основные принципы работы в различных 

программных комплексах данного 

направления, умение решать другие 

задачи при помощи этого направления 

Лабораторные работы 

Контрольные работы  

Экзамен  

ИПК – 4.2. Применяет 

современные 

информационные ресурсы 

для обработки 

гидрометеорологической 

информации 

Уметь: 

Применять свои знания при работе со 

смежным оборудованием и программным 

обеспечение для комплексного подхода к 

решению задач данного направления 

Лабораторные работы 

Контрольные работы  

Экзамен 

Владеть: 

навыками работы с программным 

обеспечением на ПК 

Лабораторные работы 

Контрольные работы  

Экзамен 

 

Критериями оценивания при модульно-рейтинговой системе являются баллы, 

которые выставляются преподавателем за виды деятельности (оценочные средства) по 

итогам изучения модулей (разделов дисциплины), перечисленных в рейтинг-плане 

дисциплины (для экзамена: текущий контроль – максимум 40 баллов; рубежный контроль – 

максимум 30 баллов, поощрительные баллы – максимум 10). 

Шкалы оценивания:  

для экзамена: 

от 45 до 59 баллов – «удовлетворительно»; 

от 60 до 79 баллов – «хорошо»; 

от 80 баллов – «отлично». 

 



  

 

Рейтинг – план дисциплины  

 

«Специализированный ГИС практикум по гидрометеорологии» 

 

направление 05.03.04 «Гидрометеорология», профиль «Гидрология суши и 

гидрометеорологический мониторинг»  

курс 2, семестр 4 

 

Виды учебной деятельности 

студентов 

Балл за конкретное 

задание 

Число заданий 

за семестр 

Баллы 

Минимальный Максимальный 

Модуль 1. Определение геоинформационных систем (ГИС).  Общие представления о 

гидрометеорологической информационной системе. Организация баз данных в гидрометеорологических 

ИС. 

Текущий контроль 

Выполнение и защита 

лабораторных  работ  
5 за 1 работу 5 работ 0 25 

Рубежный контроль 

Контрольная работа (тест) 1,0 за 1 вопрос 25  вопросов 0 25 

Всего по модулю 0 50 

Модуль 2. Особенности применения математического моделирования в гидрометеорологических ИС. 

Обработка гидрометеорологических данных.  Вывод и визуализация данных. Организация баз данных в 

гидрометеорологических ИС. 

Текущий контроль 

Выполнение и защита 

лабораторных  работ  
5 за 1 работу 5 работ 0 25 

Рубежный контроль 

Контрольная работа (тест) 1,0 за 1 вопрос 25  вопросов 0 25 

Всего по модулю 0 50 

Поощрительный рейтинг за семестр 

1. Участие в олимпиаде по 

«Гидрометеорологии» 

2. Публикация статей 

3. Выступление на конференциях 

10 1 0 10 

Всего по поощрительному рейтингу 0 10 

Посещаемость (баллы вычитаются из общей суммы набранных баллов) 

Посещение   лекционных занятий По положению 7 занятий 0 -6 

Посещение лабораторных 

занятий 
По положению 13 занятий 0 -10 

Всего по посещаемости 0 -16 

Итоговой контроль 

Зачет   - - 

ИТОГО 0 110 

 

 

 

 

 

 

 

 

 

 



  

ЗАЧЕТ 

 

Зачет выставляется студенту автоматически, если он в течение семестра набрал 60 и 

более баллов при выполнении заданий текущего и рубежного контроля. В случае, если к 

началу зачетной недели студент не набирает минимума баллов для выставления зачета, он в 

ходе периода пересдач сдает задания текущего контроля и добирает необходимое количество 

баллов.  

 

ПРАКТИЧЕСКИЕ (ЛАБОРАТОРНЫЕ) РАБОТЫ 

 

 

Лабораторная работа № 1. Определение морфометрических, ландшафтных и 

гидрографических характеристик речного водосбора.  

Цель задания: Определить границы, площадь, центр тяжести, среднюю высоту, уклон 

речного водосбора; Определить длину исследуемой рекеи и общую протяженность русловой 

сети, коэффициенты густоты речной сети;Определить площадь озер, болот, залесенных 

территорий.  

Порядок выполнения задания: 

Создание и привязка ГИС-проекта.  Добавить в новый ГИС-проект тематические слои 

– русловой сети, озер, болот и лесов, и привязанный растровый файл с топографической 

картой. Выбрать для нового ГИС-проекта проекцию и систему координат.  

Определение границ и центра тяжести речного водосбора. Границы проводятся по 

наивысшим отметкам на периферии водосбора и с учетом косвенных признаков, в частности, 

положения истоков притоков вблизи водораздела, береговой линии водоемов и т.п. Для 

определения границ водосборов необходимо создать новый полигональный шейп-файл, 

используемый для хранения и отображения плановых объектов.  

Идентификация объектов в пределах исследуемого речного водосбора и определение 

их размеров.  

Определение средней высоты и уклона водосбора на основе ЦМР. Загрузить файл с 

моделью рельефа. Для получения значений средней высоты водосбора необходимо открыть 

атрибутивную таблицу созданного растра – нажать правой кнопкой на название столбца со 

значениями абсолютных высот в растровых ячейках – выбрать команду Statistics.  

Результат выполнения задания:  Составить пояснительную записку (с анализом 

точности полученных величин) и оформить задание в соответствии с требованиями. 

Полученные характеристики свести в единую таблицу и сравнить с опубликованными в 

справочной литературе.  

 

Лабораторная работа № 2. Основы работы с пространственными данными 

(визуализация). Создание климатической карты мира.  

Цель задания: Визуализация данных на карте с использованием слоев различных 

моделей данных и объектов. 

Порядок выполнения задания: 

Запустите приложение ArcMap и откройте окно Catalog, нажав кнопку  на панели 

инструментов. Раскройте базу данных MapData.gdb и изучите ее содержимое. Дважды 

щелкните на слое Climates и перейдите на вкладку XY Coordinate System. 

Оформление базовых слоев. Добавьте на карту слой Countries, просто перетащив 

его из окна каталога. Дважды щелкните на названии слоя Countries и перейдите на вкладку 

Symbology. Внимательно изучите список способов изображения слева. Они разделены на 

категории Features (единый символ), Categories (качественные характеристики), Quantities 

(количественные  характеристики), Charts (картодиаграммы), Multiple Attributes (способы 

изображения по нескольким атрибутам). Разверните каждую группу и щелкните на 

каждом способе. Выберите способ единого символа (Features > Single symbol).  



  

Измените проекцию карты на проекцию Робинсона (Robinson). Ее можно найти в 

группе Projected Сoordinate Systems > World. Обратите внимание на то, как изменятся 

очертания объектов. 

Добавьте на карту слой Coast, расположите его поверх слоя Countries и измените 

цвет линии на Delft Blue. 

Добавьте на карту слой Rivers расположите его поверх слоя Coast и измените цвет 

линии на Delft Blue, а толщину сделайте равной 0,5 пиксела. 

Добавьте на карту слой Lakes, расположите его поверх слоя Rivers . 

Добавьте на карту слой Cities, расположите его поверх слоя Lakes. 

Оформление данных о климате и морских течениях. Добавьте на карту 

слой Сlimates, расположите его внизу таблицы содержания.  Откройте таблицу атрибутов 

слоя Сlimates, щелкнув на его названии правой кнопкой мыши и выбрав команду Open 

Attribute Table. Найдите в ней столбец Type, просмотрите его значения. Это поле таблицы 

хранит информацию о типе климата для каждой области. Вы будете использовать ее для 

классификации при отображении данного слоя. Найдите поля Shape и ObjectID. 

Климатические пояса показываются на картах способом качественного фона. 

Добавьте на карту слой Сurrents, расположите его поверх слоя Сlimates. Этот слой 

содержит данные о течениях OSCAR (Ocean Surface Current Analyses – Real time), 

осредненные с 1993 по 2003 год. 

Настройка подписей. Включите механизм размещения подписей Maplex. Дважды 

щелкните на слое Cities, и перейдите на вкладку Labels. Включите подписи для слоя Cities.  

Настройка компоновки. Переключитесь в вид компоновки с помощью команды 

меню View — Layout View. Добавьте на карту легенду с помощью команды Insert > 

Legend, включив в нее только слои Климат и Течения.  

Разместите над картой текст «КЛИМАТ И ОСНОВНЫЕ ОБЪЕКТЫ 

ГИДРОСФЕРЫ». 

Разместите под картой по центру численный масштаб 1:90 000 000. 

Разместите в правом нижнем углу карты текст «Выполнил» и свое ФИО. 

Результат выполнения задания:  Экспортируйте карту из режима компоновки в 

формат PNG с разрешением 300 точек на дюйм с помощью команды File > Export Map. 

Сохраните его в свою директорию. Вставьте карту в отчетный файл. 

 

Лабораторная работа № 3. Анализ гидрографических сетей.  

Цель задания: научиться моделировать речную сеть с помощью геометрических 

методов. 

Порядок выполнения задания: 

Откройте ArcMap. Щелкните правой кнопкой мыши по домашнему каталогу 

(Home) и выберите New > File Geodatabase для того, чтобы создать новую базу геоданных. 

Щелкните по Ex.gdb правой кнопкой мыши и выберите пункт Make Default Geodatabase. 

Эта команда указывает системе, что все результаты обработки данных следует помещать в 

выбранную базу геоданных. 

Добавьте в базу геоданных Ex.gdb новый набор данных Hydro. Для этого щелкните 

правой кнопкой мыши на названии базы геоданных и в контекстном меню выберите New > 

Feature Dataset. 

В следующем окне вам просят задать проекцию. Щелкните на кнопке  Add 

Coordinate System и в ниспадающем меню выберите команду Import. Найдите слой Border 

базе геоданных Satino.gdb и дважды кликните на нем. Параметры проекции автоматически 

подставятся из созданного ранее слоя. Убедитесь, что проекция 

называется WGS_1984_UTM_Zone_37N. 

Создайте новый класс пространственных объектов Streams внутри набора 

данных Hydro. Для этого щелкните правой кнопкой мыши по набору данных Hydro и в 

контекстном меню выберите пункт New—Feature Class. 



  

В первом диалоге введите название класса Streams, его псевдоним 

(alias) Водотоки и из ниспадающего списка выберите тип класса Line Features. Нажмите 

Далее два раза, чтобы пропустить второй диалог. 

Нажмите кнопку Import и найдите класс WaterLine в базе геоданных  Satino.gdb, 

дважды щелкните на нем. Названия и типы полей автоматически подставятся в список.  

Нажмите Finish. Проверьте, чтобы в вашей таблице содержания было 3 

слоя: Водотоки, Гидрография (линии) и Гидрография (полигоны). Копирование и 

цифрование линий водотоков. Щелкните правой кнопкой мыши на слое Водотоки и 

выберите пункт меню Edit Features > Start Editing, чтобы начать редактирование. Выделите 

все водотоки из слоя Гидрография (линии). Для этого щелкните правой кнопкой мыши по 

слою Гидрография (линии) и в контекстном меню выберите пункт Selection > Select All. 

Скопируйте выделенные водотоки в буфер обмена через команду главного меню Edit > 

Copy. 

Вставьте скопированные объекты в слой Водотоки. Для этого воспользуйтесь 

стандартной командой главного меню Edit > Paste и в появившемся диалоге выберите в 

качестве целевого слой Водотоки. 

Снимите выделение с водотоков, нажав кнопку  Clear Selected Features на панели 

инструментов Tools. Удалите слой Гидрография (линии) из таблицы содержания. В этом 

задании он больше вам не понадобится. Переключитесь в окно Create Features c помощью 

кнопки  на панели Tools и выберите Водотоки в списке цифруемых объектов.  

Приблизьтесь к верховьям Протвы в западной части карты. Для навигации 

используйте колесико мыши (масштабирование) и кнопку  на клавиатуре (перемещение). 

Рекомендуемый диапазон масштабов для цифрования — 1:1 500–1:2000. Вы можете его 

отслеживать вверху окна. Щелкните посередине полигона в месте начала реки и начните 

цифровать линию примерно по осевой линии полигона с определенным интервалом. 

Щелкните мышью в месте, где вы хотите поставить точку, затем переместите курсор к 

месту следующей точки, щелкните еще раз, и так далее. Не увлекайтесь и не расставляйте 

точки слишком часто. Оцифруйте осевую линию Протвы целиком с запада на восток — 

это займет у вас некоторое время. 

Когда линия будет полностью оцифрована, щелкните дважды мышью в последней 

точке, или нажмите. Сохраните изменения, выбрав на панели Editor команду Editor > Save 

Edits. 

Снимите выделение с водотоков, нажав кнопку  Clear Selected Features на панели 

инструментов Tools. Нажмите глобус  Full extent, чтобы все объекты поместились на 

экране. 

Притягивание (снэппинг) притоков и разрезание осевой линии основных рек. 

Найдите устье реки Межиловки при впадении в Протву (западная часть полигона) и 

увеличьтесь так, чтобы было хорошо видно место впадения. Возьмите стрелку  на 

панели Editor и дважды щелкните на линии ручья. Должны появиться вершины. Потяните 

за последнюю вершину и пристыкуйте ее к линии реки. Щелкните на пустом месте, чтобы 

завершить редактирование. 

Повторите операцию для всех остальных ручьев. Перемещайтесь по карте, 

используя клавишу. Не забудьте также про Исьму. Сохраните изменения, выбрав 

команду Editor > Save Edits 

Помимо сохранения связности для геометрической сети очень важно, чтобы линии 

были разрезаны на сегменты между пересечениями.  

Выделите на карте Протву и приблизьтесь к месту впадения в нее реки Межиловки. 

Найдите на панели Editor инструмент разрезания линии  и щелкните мышью в месте 

впадения ручья в Протву. Линия Протвы разобьется этой точкой на 2 части. 

Повторите процедуру с выделением Протвы и разрезанием для всех остальных 

притоков. Разрежьте аналогичным образом остальные водотоки. Сохраните изменения, 

выбрав команду Editor > Save Edits. Завершите редактирование, выбрав команду Editor > 

Stop Editing. Сохраните документ карты. 



  

Установка точки стока. Перейдите в окно Каталога, щелкните правой кнопкой 

мыши по набору данных Hydro и выберите пункт New > Feature Class. Задайте классу 

имя Sink и точечный тип Point Features. Остальные параметры оставьте по умолчанию. 

Смените символ слоя Sink на кружок голубого цвета диаметром 10 пикселов. Включите 

режим редактирования с помощью команды Edit Features > Start Editing, в окне Create 

Features выберите Sink и поставьте точку на восточной оконечности реки Протвы (правый 

край карты). Сохраните изменения и завершите режим редактирования. Добавьте на карту 

слой горизонталей ContoursBasic из базы данных  Satino.gdb и смените цвет линий на 

бледно-серый. Переместите его вниз в качестве основы. Отключите слой Гидрография 

(полигоны) и нажмите кнопку  Full extent, чтобы вся территория полигона поместилась на 

экране. 

Построение и настройка геометрической сети.  Перейдите в окно Каталога, 

щелкните правой кнопкой мыши по набору данных Hydro и выберите пункт New > 

Geometric Network. Оставьте Hydro_Net в качестве имени по умолчанию и установите 

расстояние принудительного снэппинга линий равным 1 м. Эта опция будет полезна, если 

вы где-то не дотянули устье притока до реки. Оно дотянется автоматически. 

Нажмите Далее. В следующем окне нажмите Select All, чтобы выбрать слои, участвующие 

в построении сети. Нажмите Далее. Перед вами окажется диалог настройки 

ролей. Junction — это узел, Edge — это ребро. Для слоя Sink установите значение 

параметра Sources & Sinks равным Yes. Система будет знать, что этот слой содержит 

точки, являющиеся истоками либо стоками. Нажмите Finish в последнем диалоге, чтобы 

завершить создание сети. После того как будет построена геометрическая сеть, в таблицу 

содержания добавятся 3 новых слоя: Водотоки (ребра 

сети), Hydro_Net_Junctions (сочленения в сети) и Sink (точка стока). Удалите новые 

слои Водотоки и Sink, поскольку они дублируют старые.  Включите режим 

редактирования и откройте таблицу атрибутов слоя Sink. 

Установите для единственной точки в этом слое поле AncillaryRole равным 2 (Sink). 

Если список не отображается, просто введите в ячейку 2. Обратите внимание на то, что 

есть и противоположный вариант — Source (исток). 

Сохраните изменения, выбрав пункт меню Editor > Save Edits. 

Щелкните правой кнопкой мыши на пустом поле вверху окна и откройте панель 

инструментов Utility Network Analyst, предназначенную для работы с геометрической 

сетью. 

Выберите в меню пункт Flow > Display Arrows для того чтобы система 

автоматически показала направление течения. Вдоль отрезков будут показаны кружки, 

означающие, что направление еще не задано. 

Нажмите кнопку  Set Flow Direction. Кружки должны смениться стрелочками, 

указывающими направление течения. Просмотрите разные части карты и убедитесь в том, 

что направление течения задано одинаково верно для всех водотоков. Завершите сеанс 

редактирования, выбрав на панели Editor пункт меню Editing > Stop Editing.   

Анализ и редактирование геометрической сети.  Откройте меню флагов и барьеров 

на панели инструментов Utility Network Analyst. Поставьте флажок в месте впадения 

реки Межиловки в Протву. В списке Trace Task выберите задачу Trace 

Upstream (трассировать вверх по течению) и нажмите кнопку  Solve. 

Инструмент анализа выделит водотоки, расположенные выше по течению 

относительно заданной точки. Весь их сток в конечном счете попадает в данную точку. 

Смените задачу на Trace Downstream и опять нажмите кнопку  Solve. Инструмент анализа 

построит маршрут вниз по течению. Поставьте еще один флажок в верховьях ручья 

Язвицы и запустите анализ в режиме Find Path. Будет построен маршрут между двумя 

точками. 

Поставьте точечный барьер в месте впадения Исьмы в Протву и попробуйте еще раз 

рассчитать маршрут. Очистите флаги и барьеры, выбрав Analysis > Clear Flags и Analysis > 

Clear Barriers. Попробуйте поэкспериментировать с разными режимами расчетов в 

меню Trace Task и расстановкой флагов и барьеров. Включите режим редактирования 



  

снова и приблизьтесь к месту впадения любого ручья в Протву. Выделите узел сочленения 

и переместите его в сторону. Сохраните документ карты еще раз. 

Результат выполнения задания:  Экспортируйте карту из режима компоновки в 

формат PNG с разрешением 300 точек на дюйм с помощью команды File > Export Map. 

Сохраните его в свою директорию. Вставьте карту в отчетный файл. 

 

Лабораторная работа № 4.  Анализ цифровой модели рельефа.  

Цель задания: научиться на основе цифровой модели рельефа выделять водотоки и их 

водосборные бассейны в автоматическом режиме. Осуществлять расчет статистики по 

высотам в рамках выделенных бассейнов 

Порядок выполнения задания: 

Подключитесь в окне каталога к вашей папке Ex. Убедитесь, что в ней находится база 

геоданных Ex.gdb. Используя контекстное меню базы данных, назначьте ее базой данных по 

умолчанию.  Добавьте на карту слой dem. Это цифровая модель рельефа в растровом 

формате. Измените оформление слоя.  

Измените красный цвет шкалы на оранжевый. Для этого в контекстном меню 

цветовой шкалы выберите команду Properties…. В появившемся диалоге дважды щелкните 

на бело-красном градиенте и замените красный цвет на оранжевый Electron Gold.  

Завершите настройку шкалы, нажав ОК и еще раз ОК. 

Измените сортировку значений на вкладке Symbology таким образом, чтобы вверху 

оказались самые большие высоты. Нажмите ОК, чтобы закрыть диалог настройки слоя. 

Измените название слоя dem на «Послойная окраска».  Дополнительно к послойной 

окраске постройте горизонтали, чтобы усилить пластику рельефа. Для этого запустите 

инструмент геообработки Spatial Analyst Tools > Surface > Contour и заполните его 

параметры.  

Растр направления тока показывает в каждой ячейке направление максимального 

уклона. Он необходим для построения водосборных бассейнов и прочих задач 

гидрологического и морфометрического анализа. Для построения растра направлений тока 

запустите инструмент Spatial Analyst Tools > Hydrology > Flow Direction и заполните его 

параметры.  

Для построения растра аккумуляции тока запустите инструмент Spatial Analyst Tools > 

Hydrology > Flow Accumulation и заполните его параметры.  

Чтобы сделать отображение растра аккумуляции тока более наглядным, откройте его 

свойства и на вкладке Symbology измените растяжку гистограммы на метод Histogram 

Equalize (Выравнивание гистограммы).  

Для получения векторных линий водотоков воспользуйтесь инструментом Spatial 

Analyst Tools > Hydrology > Stream to Feature и заполните его параметры. 

Переименуйте полученный слой в Водотоки. Визуализируйте водотоки в 

соответствии с их порядками от 1 до 4. 

Запустите инструмент Spatial Analyst Tools > Hydrology > Snap Pour Point и заполните 

его параметры. Для построения границ водосборных бассейнов запустите инструмент Spatial 

Analyst Tools > Hydrology > Watershed и заполните его параметры. Конвертируйте 

полученные бассейны в векторные полигоны. Для этого запустите инструмент Conversion 

Tools > From Raster > Raster to Polygon со следующими параметрами.  

Переименуйте полученный слой в «Водосборные бассейны» и измените его символ на 

тонкую красную линию без заливки.  

Оформление итоговой карты. Установите масштаб карты равным 1:500 000. 

Переключитесь в режим компоновки. Измените ориентировку листа на альбомную.  

Добавьте на карту численный масштаб и заголовок «Водотоки разных порядоков и их 

водосборные бассейны».  Добавьте легенду со следующими слоями: Водотоки, Водосборные 

бассейны и Послойная окраска. Добавьте пометку «Для каждого бассейна указана средняя 

высота в метрах над уровнем моря» 



  

Результат выполнения задания: Экспортируйте карту из режима компоновки в 

формат PNG с разрешением 300 точек на дюйм с помощью команды File > Export Map. 

Сохраните его в свою директорию. Вставьте карту в отчетный файл. 

 

Лабораторная работа № 5. Привязка и цифрование гидрогеологической карты. 

Цель задания: знакомство с привязкой, трансформированием и цифрованием 

геоизображений, элементами базовых технологий ГИС (оверлей, пространственные 

запросы). 

Порядок выполнения задания: 

Откройте приложение ArcMap, создайте новый документ карты и сохраните его в 

свою папку Ex. Подключитесь в окне каталога к папке Ex. Убедитесь, что в ней находится 

база геоданных Don.gdb и растровый файл DonArtesian.png. Раскройте базу геоданных и 

перенесите на карту классы Lakes и Rivers.  Присвойте слою Lakes символ с голубой 

заливкой и синей обводкой. Настройте оформление слоя Rivers.  

Включите опцию подписи рек. Перейдите на вкладу Labels и отметьте флажок Label 

features in this layer. Выберите поле Название в качестве поля для подписей, смените их цвет 

на темно-синий и установите криволинейное размещение вдоль линии. Нажмите ОК. В 

результате операции все реки будут подписаны. 

Чтобы были подписаны только крупнейшие реки, необходимо использовать 

определяющий запрос на языке SQL. Для этого откройте снова свойства слоя и на вкладке 

Labels выберите метод «Define classes of features and label each class separately». 

Добавьте на карту из базы данных слой DonArtesian.png и поместите его 

непосредственно под слоем Rivers. При добавлении слоя появится диалоговое окно, 

предупреждающее о том, что файл не имеет привязки. Закройте его. Поместите карту в центр 

окна ArcMap. 

Откройте панель инструментов Georeferencing. Убедитесь, что в ее списке выбран 

файл DonArtesian. Выберите в ее меню команду Fit to Display, чтобы переместить 

непривязанный растр на середину области отображения. Поместите растр непосредственно 

под слоем Rivers. 

Используя инструмент расстановки контрольных точек, укажите пять контрольных 

точек в разных частях карты. Желательно, чтобы точки были равномерно распределены по 

полю карты (по краям и в центре) и не располагались на одной линии — это обеспечит 

хорошие коэффициенты трансформации. В качестве точек используйте места впадения 

притоков и впадения рек в водохранилища. 

Ознакомьтесь с доступными методами трансформирования по контрольным точкам. 

Для этого в меню Georeferencing выберите команду Transformation. По умолчанию выбрано 

аффинное преобразование. 

Осуществите трансформирование растра. На панели инструментов Georeferencing 

выберите команду меню Georeferencing > Update Georeferencing. Контрольные точки 

удалятся. 

Сохраните документ карты в формате mxd в папке отчета. 

Добавьте на карту слои Boundaries (границы) и Cities (города). Используйте для их 

отображения способ Categories и настройте отображение разными символами классов 

границ, а также городов в соответствии с численностью населения. При оформлении 

подписей городов используйте метод классифицированных подписей (прочтите 

соответствующий раздел в файле Описание функций). 

Переключитесь в режим компоновки и оформите легенду карты. Добавьте название 

«Гидрогеологическое районирование среднего течения Дона», а также масштаб и свои ФИО. 

Экспортируйте результирующую карту в файл в формате PNG и вставьте ее в отчет. 

Результат выполнения задания:  Экспортируйте карту из режима компоновки в 

формат PNG с разрешением 300 точек на дюйм с помощью команды File > Export Map. 

Сохраните его в свою директорию.Вставьте карту в отчетный файл. 

 



  

Лабораторная работа № 6. Пространственная интерполяция характеристик 

годового стока с использованием ГИС-технологий.  

Цель задания: построить региональные карты модуля годового стока и коэффициента 

вариации.  

Порядок выполнения задания: 

Подготовка данных. Создать новый XLSX-файл, в котором на отдельном рабочем 

листе для каждого из гидрологических постов сформировать ряд среднегодовых расходов 

воды.  

Импорт данных. Создать ГИС-проект с пространственной привязкой и добавить в 

него растровый файл с привязанной топографической картой и имеющиеся тематические 

шейп-файлы, в частности русловой сети и озер.  Добавить в окно содержания созданный по 

гидрологическим постам XLSX-файл. 

Построение интерполяционных карт. Создать новый полигональный шейп-файл и 

очертить в нем полигон, в границах которого будет производиться интерполяция. Построить 

кату изолиний среднемноголетнего модуля годового стока.  

Результат выполнения задания:   

Составить пояснительную записку  и оформить задание в соответствии с 

требованиями, включив в него таблицу рассчитанных данных по гидрологическим постам, 

основные карты и сведения по их точности, график региональной зависимости, описание 

алгоритмов расчетов и построений.  

 

Лабораторная работа № 7. Расчет характеристик годового стока на основе 

интерполяционных карт.  
Цель задания: определить параметры кривой обеспеченности годового стока, 

коэффициента вариации и рассчитать для неизученного водосбора среднегодовые расходы 

воды обеспеченности 10,50 и 90 %.  

Порядок выполнения задания: 

Подготовка ГИС-проекта  - выделение исследуемого водосбора.  

Определение среднемноголетней величины годового стока и коэффициента вариации. 

Выполнить расчет с помощью осреднения значений узлов грида (сетки): создать новый 

полигональный шейп-файл, внутри которого оцифровать границы исследуемого водосбора – 

обрезать по созданному шейп-файлу с границами водосбора растровые карты модуля стока и 

коэффициента вариации.  

Результат выполнения задания:  Завершение расчетов, анализ полученных 

результатов и оформление задания проводятся в соответствии с рекомендациями. 

 

Лабораторная работа № 8 Оценка плотности распределения.  
Цель задания: научиться определять плотность распределения (густоту) линейных 

объектов с помощью метода плавающего окна. 

Порядок выполнения задания: 

- Оценить плотности дорожной сети;  

- Оценить влияние радиуса поиска; 

- масштабирование значения показателя;  

-оформление слоя густоты дорожной сети;  

- Оформление итоговой карты.  

Результат выполнения задания:  Растры густоты дорожной сети, полученные 

методом простого подсчета длины линий и путем ядерного сглаживания с разным радиусом 

влияния. Карта густоты дорожной сети с компоновкой. 

 

Лабораторная работа № 9. Пространственная интерполяция.  
Цель задания: научиться на основе точечных данных восстанавливать поля 

распределения непрерывных показателей различными способами. Осуществлять 

визуализацию методом изолиний с послойной окраской, строить профили по полученным 

поверхностям. 



  

Порядок выполнения задания: 

Добавить на карту границы стран и точки наблюдений, оформить в соответствии с 

указаниями; 

Оценить максимально возможное разрешение растра; 

Построить поверхность методом обратно взвешенных расстояний; 

Построить поверхность методом естественного соседа; 

Построить поверхность методом сплайнов с натяжением; 

Построить поверхности методом полиномиального тренда со степенями 1,2,3,4,5; 

Построить поверхность методом кригинга ; 

Сгладить данную поверхность фильтром с плавающим окном размера 3х3; 

Построить изолинии по данной поверхности; 

Построить профиль по меридиану 38° з.д.; 

Оформить карту с легендой и масштабом. 

Результат выполнения задания:  Поверхности температуры за 30.01.2011, 

построенные различными методами; поверхность кригинга, полученная после обработки 

фильтром 3х3; изолинии по данной поверхности с шагом 2,5 градуса; профиль температуры 

по меридиану 38° з.д.; карта с названием, легендой, масштабом и профилем 

 

Лабораторная работа № 10. Трехмерное моделирование.  
Цель задания: знакомство с трехмерными моделями данных, трехмерной 

визуализацией и анализом в ГИС 

Порядок выполнения задания: 

Добавить на карту ЦМР и отобразить ее методом горизонталей с послойной окраской; 

Подготовить вспомогательные объекты для учета препятствий; 

 Преобразовать растровые данные в триангуляционные; 

Визуализировать данные в трехмерной среде (приложение ArcScene); 

Выполнить анализ зоны видимости наблюдательного пункта при разных положениях 

его высоты. 

Результат выполнения задания:  Трехмерная модель Сатинского учебного полигона, 

зоны видимости и линии небосвода для двух обзорных точек 

 

Критерии оценки (в баллах): 
5 баллов выставляется студенту, если при выполнении практической работы допущена 1 

несущественная ошибка. 

4 балла выставляется студенту, если при выполнении практической работы допущена 1 

существенная ошибка или при решении допущена 1 значительная ошибка. 

3 балла выставляется студенту, если при выполнении практической работы студент не 

полностью выполнил задание или при решении допущены 2 значительные ошибки. 

2 балла выставляется студенту, если при выполнении практической работы студент не 

полностью выполнил задание или при решении допущены 3 значительные ошибки. 

1 балл выставляется студенту, если при выполнении практической работы студент не 

полностью выполнил задание и при решении допущена 1 грубая ошибка. 

 

ЗАДАНИЯ ДЛЯ КОНТРОЛЬНОЙ РАБОТЫ 
 

Контрольная работа в 1 варианте в виде тестирования. Каждый ответ на тестовый 

вопрос оценивается в 1,0 балла, согласно рейтинг-плану. В первом и втором модулях в тесте 

по 25 вопросов.  Тестирование проводится в личном кабинете студента. 

 

Примеры контрольных работ 

Модуль 1. 

Вопросы рубежного контроля.  



  

 
Модуль 2. 

Вопросы рубежного контроля. 

 
 

 

 

Критерии оценки (в баллах): 
1 балл выставляется студенту за каждый правильный ответ. Общим результатом 

контрольной работы является сумма всех правильных ответов.  

В модуле 1 максимальное количество – 25 баллов (25 вопросов-тестов). 

В модуле 2 максимальное количество – 25 баллов (25 вопросов-тестов) 



  

Рейтинг – план дисциплины  

 

«Специализированный ГИС практикум по гидрометеорологии» 

 

направление 05.03.04 «Гидрометеорология», профиль «Гидрология суши и 

гидрометеорологический мониторинг»  

курс 3, семестр 5 

 

Виды учебной деятельности 

студентов 

Балл за конкретное 

задание 

Число заданий 

за семестр 

Баллы 

Минимальный Максимальный 

Модуль 1. Оптимизация гидрометеорологических ИС. Средства доступа к гидрометеорологическим базам 

данных. Приложение «клиент». Приложение «сервер». 

Текущий контроль 

Выполнение и защита 

лабораторных  работ 
5 за 1 работу 4 работы 0 20 

Рубежный контроль 

Контрольная работа (тест) 0,5 за 1 вопрос 30 вопросов 0 15 

Всего по модулю 0 35 

Модуль 2. Особенности гидрометеорологических ИС для Интернет.  Проблемы безопасности в 

гидрометеорологических ИС. Обзор современных гидрометеорологических ИС. 

Текущий контроль 

Выполнение и защита 

лабораторных  работ 
5 за 1 работу 4 работы 0 20 

Рубежный контроль 

Контрольная работа (тест) 0,5 за 1 вопрос 30 вопросов 0 15 

Всего по модулю 0 35 

Поощрительный рейтинг за семестр 

4. Участие в олимпиаде по 

«Гидрометеорологии» 

5. Публикация статей 

6. Выступление на конференциях 

10 1 0 10 

Всего по поощрительному рейтингу 0 10 

Посещаемость (баллы вычитаются из общей суммы набранных баллов) 

Посещение   лекционных занятий По положению 9 занятий 0 -6 

Посещение лабораторных 

занятий 
По положению 17 занятий 0 -10 

Всего по посещаемости 0 -16 

Итоговой контроль 

Экзамен    0 30 

ИТОГО 0 110 

 

 



  

ЭКЗАМЕНАЦИОННЫЕ БИЛЕТЫ 

   

Экзамен проводится в 1 варианте в виде тестирования. Каждый ответ на тестовый 

вопрос оценивается в 1,0 балла, согласно рейтинг-плану. В тесте 30 вопросов.  Тестирование 

проводится в личном кабинете студента. 

Студент, который в течение семестра набрал баллы для удовлетворяющей его оценки, 

получает итоговую оценку автоматически без явки на экзамен 

 

Примеры тестовых вопросов на экзамен 

 
Критерии оценки (в баллах): 

1,0 балла выставляется студенту за каждый правильный ответ. Общим результатом 

экзамена является сумма всех правильных ответов.  

Максимальное количество – 30 баллов (30 вопросов-тестов). 

 

 

ПРАКТИЧЕСКИЕ (ЛАБОРАТОРНЫЕ) РАБОТЫ 

 

Лабораторная работа № 1. Привязка растров по координатам в программе 

ArcGis. 
Цель задания: научиться привязать растры по координатам в программе  ArcGis. 

Порядок выполнения задания: 

1. Скачать топографические карты по Республике Башкортостан;  

2. Привязать их с помощью пространственной привязки.  

Результат выполнения задания: привязанные растры по территории Республики 

Башкортостан по координатам.   

 

Лабораторная работа № 2. Создание shp-файлов в программе ArcGis. 
Цель задания: научиться создавать  shp-файлы в программе  ArcGis. 

Порядок выполнения задания: 

1. Используя привязанные растры по Республике Башкортостан создать шейп-файлы.  

2. Редактор – начать редактирование – создать объекты – полигон – линии – точечные 

объекты. 

3. Должны быть созданы шейп-файлы «Граница РБ», «Метеостанции РБ», «Реки РБ».  

Результат выполнения задания: шейп-файлы по территории Республики 

Башкортостан.   

 

Лабораторная работа № 3. Заполнение атрибутивной таблицы в программе 

ArcGis. 
Цель задания: научиться заполнять атрибутивные таблицы в программе  ArcGis. 

Порядок выполнения задания: 

Используя шейп-файлы  по Республике Башкортостан заполнить их атрибутивные 

таблицы.  



  

Добавить в атрибутивную таблицу "Метеостанции (Метеопосты)" данные по суммам 

атмосферных осадков (за теплый период; за холодный период, за год).  

Результат выполнения задания: заполненные атрибутивные таблицы по территории 

Республики Башкортостан.   

 

Лабораторная работа № 4. Применение некоторых инструментов модуля Arcgis 

Spatial Analyst в программе ArcGis. 
Цель задания: научиться применять  некоторых инструментов модуля Arcgis Spatial 

Analystв программе  ArcGis. 

Порядок выполнения задания: 

Используя шейп-файлы  по Республике Башкортостан и их атрибутивные таблицы.  

Создать Карту по распределению сумм атмосферных осадков (а - за теплый период; б 

- за холодный период). 

Результат выполнения задания: Карта по распределению сумм атмосферных осадков 

(а - за теплый период; б - за холодный период). 

 

Лабораторная работа № 5. Создание диаграмм в программе ArcGis. 
Цель задания: научиться на основе точечных данных представлять информацию в 

виде различных типов диаграмм. 

Порядок выполнения задания: 

Добавить на карту границу Республики Башкортостан  

Построить диграммы  

Оформить карту с легендой и масштабом 

Результат выполнения задания: Карта по объемам выбросов загрязняющих веществ в 

атмосферу.  

 

Лабораторная работа № 6. Создание карты режима увлажнения Республики 

Башкортостан в программе ArcGis. 
Цель задания: научиться создавать карты режима увлажнения.  

Порядок выполнения задания: 

Добавить на карту границу Республики Башкортостан  

Создать карту режима увлажнения 

Оформить карту с легендой и масштабом 

Результат выполнения задания: Карта режима увлажнения Республики 

Башкортостан.   

 

Лабораторная работа № 7. Создание карты ИЗА по г. Уфа Республики 

Башкортостан в программе ArcGis. 
Цель задания: научиться создавать карты ИЗА.  

Порядок выполнения задания: 

Добавить на карту границу города Уфы  

Создать карту по ИЗА 

Оформить карту с легендой и масштабом 

Результат выполнения задания: Карта ИЗА г. Уфа Республики Башкортостан.   

 

Лабораторная работа № 8. Выделение водосборных бассейнов по ЦМР. 

Определение некоторых гидрографических характеристик водосборов и водотоков по 

ЦМР в программе ArcGis. 
Цель задания: научиться водосборные бассейны по ЦМР.  

Порядок выполнения задания: 

Добавить на карту ЦМР  

Создать карту по водосборам рек.  

Оформить карту с легендой и масштабом 



  

Результат выполнения задания: Карта водосбора реки по выбору Республики 

Башкортостан.   

 

Критерии оценки (в баллах): 
5 баллов выставляется студенту, если при выполнении практической работы допущена 1 

несущественная ошибка. 

4 балла выставляется студенту, если при выполнении практической работы допущена 1 

существенная ошибка или при решении допущена 1 значительная ошибка. 

3 балла выставляется студенту, если при выполнении практической работы студент не 

полностью выполнил задание или при решении допущены 2 значительные ошибки. 

2 балла выставляется студенту, если при выполнении практической работы студент не 

полностью выполнил задание или при решении допущены 3 значительные ошибки. 

1 балл выставляется студенту, если при выполнении практической работы студент не 

полностью выполнил задание и при решении допущена 1 грубая ошибка. 

 

ЗАДАНИЯ ДЛЯ КОНТРОЛЬНОЙ РАБОТЫ 
 

Контрольная работа в 1 варианте в виде тестирования. Каждый ответ на тестовый 

вопрос оценивается в 0,5 балла, согласно рейтинг-плану. В первом и втором модулях в тесте 

по 30 вопросов.  Тестирование проводится в личном кабинете студента. 

 

Примеры контрольных работ 

Модуль 1. 

Вопросы рубежного контроля.  

 
Модуль 2. 

Вопросы рубежного контроля. 
 

 

Критерии оценки (в баллах): 
0,5 балла выставляется студенту за каждый правильный ответ. Общим результатом 

контрольной работы является сумма всех правильных ответов.  

В модуле 1 максимальное количество – 15 баллов (30 вопросов-тестов). 

В модуле 2 максимальное количество – 15 баллов (30 вопросов-тестов) 

 



  

5. Учебно-методическое и информационное обеспечение дисциплины 

5.1. Перечень основной и дополнительной учебной литературы, необходимой для 

освоения дисциплины 

 

Основная литература: 

1. Геоинформационные системы: учебное пособие/ Ловцов Д.А., Черных А.М. – М.: 

Российская академия правосудия, 2012. – 191 с. 

http://biblioclub.ru/index.php?page=book&id=140619 

2. Фатхутдинова, Р.Ш. Применение ГИС-технологий при решении 

гидрометеорологических задач: учебно-методическое пособие / Р.Ш. Фатхутдинова, К.Д. 

Силантьев; Башкирский государственный университет. — Уфа: РИЦ БашГУ, 2020. — 

Электронная версия печатной публикации. — Доступ возможен через Электронную 

библиотеку БашГУ. — <URL: https://elib.bashedu.ru/dl/local/Fatkhutdinova_ 

Silantyev_Primenenie GIS-technologies pri resheny gidrometeorolog_ump_2020.pdf>. 

 

Дополнительная литература: 

1. Географические информационные системы: методические указания / ФГБОУ ВПО 

«Нижегородский государственный архитектурно-строительный университет», Кафедра 

иностранных языков ; сост. Н.Г. Надеждина. - Нижний Новгород: ННГАСУ, 2014. - 45 с. 

http://biblioclub.ru/index.php?page=book&id=427431 

2. Геоинформационные системы и дистанционное зондирование: учебное пособие / 

К.В. Шошина, Р.А. Алешко ; Министерство образования и науки Российской Федерации, 

Федеральное государственное автономное образовательное учреждение высшего 

профессионального образования Северный (Арктический) федеральный университет им. 

М.В. Ломоносова. - Архангельск : ИД САФУ, 2014. - Ч. 1. - 76 с. 

http://biblioclub.ru/index.php?page=book&id=312310 

3. Картография с основами топографии : учебник / Л. А. Фокина.— М. : ВЛАДОС, 

2005 .— 335 с. Абонемент № 3 (4 экземпляра); Абонемент № 8 (55 экземпляров).  

4. Коноплева, И.А. Информационные технологии: учебное пособие / И.А. Коноплева, 

О.А. Хохлова, А.В. Денисов; под ред. И.А. Коноплевой. - 2-е изд., перераб. и доп. - Москва : 

Проспект, 2014. - 328 с. http://biblioclub.ru/index.php?page=book&id=251652 

5. Трифонова, Т.А. Почвенно-продукционный потенциал экосистем речных 

бассейнов на основе наземных и дистанционных данных / Т.А. Трифонова, Н.В. Мищенко. - 

Москва: Издательство ГЕОС, 2013. - 271 с. 

http://biblioclub.ru/index.php?page=book&id=469028 

6. Лебедев, С. В. Пространственное ГИС-моделирование геоэкологических объектов 

в ArcGIS : учебник: / С. В. Лебедев, Е. М. Нестеров ; Российский государственный 

педагогический университет им. А. И. Герцена. – Санкт-Петербург : Российский 

государственный педагогический университет им. А.И. Герцена (РГПУ), 2018. – 280 с. : ил., 

табл. URL: https://biblioclub.ru/index.php?page=book&id=577800 

7. Добрякова, В. А. Основы ArcGIS: учебно-методическое пособие для студентов 

направлений «География», «Гидрометеорология», «Экология и природопользование», 

«Картография и геоинформатика»: / В. А. Добрякова ; Тюменский государственный 

университет. – 2-е изд., перераб. и доп. – Тюмень : Тюменский государственный 

университет, 2014. – 92 с. : ил. URL: https://biblioclub.ru/index.php?page=book&id=572092 

 

5.2. Перечень ресурсов информационно-телекоммуникационной сети «Интернет» и 

программного обеспечения, необходимых для освоения дисциплины, включая 

профессиональные базы данных и информационные справочные системы  

 

1. Электронная библиотечная система «ЭБ БашГУ» - https://elib.bashedu.ru//  

2. Электронная библиотечная система издательства «Лань» - https://e.lanbook.com/  

3. Электронная библиотечная система «Университетская библиотека онлайн» - 

https://biblioclub.ru/ 

http://biblioclub.ru/index.php?page=book&id=140619
https://elib.bashedu.ru/dl/local/Fatkhutdinova_%20Silantyev_Primenenie%20GIS-technologies%20pri%20resheny%20gidrometeorolog_ump_2020.pdf
https://elib.bashedu.ru/dl/local/Fatkhutdinova_%20Silantyev_Primenenie%20GIS-technologies%20pri%20resheny%20gidrometeorolog_ump_2020.pdf
http://biblioclub.ru/index.php?page=book&id=427431
http://biblioclub.ru/index.php?page=book&id=312310
http://biblioclub.ru/index.php?page=book&id=251652
http://biblioclub.ru/index.php?page=book&id=469028
https://biblioclub.ru/index.php?page=book&id=577800
https://biblioclub.ru/index.php?page=book&id=572092


  

4. Научная электронная библиотека - elibrary.ru  (доступ к электронным научным 

журналам) - https://elibrary.ru/projects/subscription/rus_titles_open.asp 

5. Электронный каталог Библиотеки БашГУ - http://www.bashlib.ru/catalogi/  

6. Электронная библиотека диссертаций РГБ -  http://diss.rsl.ru/  

7. Государственная публичная научно-техническая библиотека России. База данных 

международных индексов научного цитирования SCOPUS - http://www.gpntb.ru.  

8. Государственная публичная научно-техническая библиотека России. База данных 

международных индексов научного цитирования Web of Science  - http://www.gpntb.ru  

Программное обеспечение: 

1. ГИС MapInfoProfessional 11.0 для Windows (русская версия) Договор №263 от 7.12.2012 г. 

2. ГИС MapInfoProfessional 12.0 (США) – лицензионный договор № 1147/2014 – У/206 от 

18 сентября 2014 года (9 ключей) 

3. ГИС «ИнГео» (Россия) - лицензия № 0914-03 от 19 сентября 2014 года для 

образовательных организаций, количество рабочих станций – не ограничено. 

4. Права на программы для ЭВМ обновление операционной системы для персонального 

компьютера WindowsProfessional 8 RussianUpgradeOLPNLAcademicEdition. Договор №104 от 

17.06.2013 г. Лицензии бессрочные. 

5. Windows 8 Russian. Windows Professional 8 Russian Upgrade. Договор №104 от 17.06.2013 г. 

Лицензии бессрочные. 

6. Microsoft Office Standard 2013 Russian. Договор №114 от 12.11.2014 г. Лицензии 

бессрочные. 

7. ArcGIS 10.1 for DesktopAdvanced (Arclnfo) LabPak. Договор №263 от 07.12.2012 г. 

Лицензии бессрочные. 

 

 6.Материально-техническая база, необходимая для осуществления 

образовательного процесса по дисциплине 
 

Наименование специальных* 

помещений и помещений для 

самостоятельной работы 

Оснащенность  специальных помещений и 

помещений для самостоятельной работы 

Перечень 

лицензионного 

программного 

обеспечения. 

Реквизиты 

подтверждающего 

документа 

1. учебная аудитория для 

проведения занятий 

лекционного типа: аудитория 

№ 711 (гуманитарный корпус), 

аудитория № 809И 

(гуманитарный корпус). 

2. учебная аудитория для 

проведения лабораторных 

работ: аудитория № 707И 

Лаборатория ИТ (компьютерный 

класс) (гуманитарный корпус), 

аудитория № 709И Лаборатория 

ИТ (компьютерный класс) 

(гуманитарный корпус). 

3. учебная аудитория для 

проведения групповых и 

индивидуальных 

консультаций:  аудитория № 

707И Лаборатория ИТ 

(компьютерный класс) 

(гуманитарный корпус), 

аудитория № 709И Лаборатория 

ИТ (компьютерный класс) 

(гуманитарный корпус), 

аудитория № 704    

Аудитория № 711 

Учебная мебель, доска, мультимедийный 

проектор BenQMX511(DLP.XGA.2700 

ANSI.High Contrast Ratio 3000, ноутбук Lenovo 

Idea Pad B 570 15.6» Inte Corei 32350M 4Gb, 

экран на штативе Screen Media Apollo формат 

183*244см   

Аудитория № 809И 

Учебная мебель, доска, мультимедийный 

проектор BenQMX511(DLP.XGA.2700 

ANSI.High Contrast Ratio 3000, ноутбук Lenovo 

Idea Pad B 570 15.6» Inte Corei 32350M 4Gb, 

экран на штативе Screen Media Apollo формат 

183*244см   

Аудитория № 707И 

Лаборатория ИТ (компьютерный класс) 

Учебная мебель, доска, персональный компьютер 

в комплекте процессор Intel Celeron G1840 2.8 

GHz, HDD 500 Gb, DDR302Gb+монитор Samsung 

SE200 Series (13шт.) 

Аудитория № 709И 

Лаборатория ИТ (компьютерный класс) 

Учебная мебель, доска, персональные 

компьютеры в комплекте № 1 iRUCorp 510 (13 

шт.). 

1. Windows 8 Russian. 

Windows Professional 8 

Russian Upgrade. 

Договор №104 от 

17.06.2013 г. Лицензии 

бессрочные. 

2. Microsoft Office 

Standard 2013 Russian. 

Договор №114 от 

12.11.2014 г. Лицензии 

бессрочные. 

3. ArcGIS 10.1 for 

DesktopAdvanced 

(Arclnfo) LabPak. 

Договор №263 от 

07.12.2012 г. Лицензии 

бессрочные. 

 



  

(гуманитарный корпус), 

аудитория № 708И Лаборатория 

ИТ (компьютерный класс) 

(гуманитарный корпус) 

4. учебная аудитория для 

текущего контроля и 

промежуточной аттестации: 
лаборатория (компьютерный 

класс) № 707И (гуманитарный 

корпус), лаборатория 

(компьютерный класс) № 709И 

(гуманитарный корпус), 

аудитория № 704    

(гуманитарный корпус), 

аудитория № 708И Лаборатория 

ИТ (компьютерный класс) 

(гуманитарный корпус) 

5. помещения для 

самостоятельной работы: 

аудитория № 704/1 

(гуманитарный корпус); 

абонемент №8 (читальный зал) 

(ауд. 815И) (гуманитарный 

корпус) 

6. помещения для хранения и 

профилактического 

обслуживания учебного 

оборудования:  № 820И 

(гуманитарный корпус). 

Аудитория № 708И 

Лаборатория ИТ (компьютерный класс) 

Учебная мебель, доска, компьютеры в составе 

DepoNeos 470Md: системный блок 3450/4Gddr 

1333/n 500G/DyD+RY, мониторы 20 (13 шт.) 

Аудитория № 704 

Учебная мебель, доска, мультимедийный 

проектор BenQMX511(DLP.XGA.2700 

ANSI.High Contrast Ratio 3000, ноутбук Lenovo 

Idea Pad B 570 15.6» Inte Corei 32350M 4Gb, 

экран на штативе Screen Media Apollo формат 

183*244см   

Аудитория № 704/1 

Учебная мебель, доска, персональные 

компьютеры: процессор Thermaltake Intel Core 2 

Duo, монитор Acer AL1916W, Window Vista, 

монитор 19" LG L1919S BF Black (LCD<TFT, 

8ms, 1280×1024, 250 кд/м, 1400:1,4:3 D-Sub), 

процессор InWin, Intel Core 2 Duo, монитор 

Flatron 700, процессор «Кламас», монитор 

Samsung MJ17 ASKN /EDC, процессор «Intel 

Inside Pentium 4», мышь и клавиатура. 

Абонемент №8 (читальный зал)  

Учебная мебель, компьютеры в сборе 

(системный блок Powercool\Ryzen 3 2200G (3.5)\ 

8Gb\ A320M \HDD 1Tb\ DVD-RW\450W\ Win10 

Pro\ Кл-раUSB\ МышьUSB\ LCDМонитор 21,5"- 

3 шт.) 

Помещение № 820И 

Учебно-наглядные пособия, мультимедийный 

проектор BenQ MX511 DLP XGA 2700 ANSI 

High Contrast Ratio 3000, ноутбук Lenovo Idea 

Pad B570 15.6 Intel Corei 32350M 4Gb, экран на 

штативе Screen Media Apollo - 183×244см 

 

 

 

 

 

 

 



  

 Приложение № 1 

 

ФГБОУ ВО «БАШКИРСКИЙ ГОСУДАРСТВЕННЫЙ УНИВЕРСИТЕТ» 

ФАКУЛЬТЕТА НАУК О ЗЕМЛЕ И ТУРИЗМА 

 

 

 

 

 

СОДЕРЖАНИЕ РАБОЧЕЙ ПРОГРАММЫ 

 

дисциплины «Специализированный ГИС практикум по гидрометеорологии» на 4,5 семестре 

 

очной формы обучения  

 

 

Вид работы Объем дисциплины  

Общая трудоемкость дисциплины (з.е. / часов) 5 з.е. / 180 ч. 

(2/3 з.е.) / (72/108 ч.) 

Учебных часов на контактную работу с преподавателем: 
93,4 

 (40,2/53,2) 

лекций 32 (14/18) 

практических/ семинарских - 

лабораторных 60 (26/34) 

других (групповая, индивидуальная консультация и иные виды 

учебной деятельности, предусматривающие работу обучающихся с 

преподавателем) (ФКР) 1,4 (0,2/1,2) 

из них, предусмотренные на выполнение курсовой работы  - 

Учебных часов на самостоятельную работу обучающихся (СР) 51,8 (31,8/20) 

из них, предусмотренные на выполнение курсовой работы  - 

Учебных часов на подготовку к 

экзамену/зачету/дифференцированному зачету (контроль) 34,8 

Примечание. В скобках указано разделение часов по семестрам (4 семестр/5 семестр). 

 

 Форма(ы) контроля: 

экзамен 5 семестр 

зачет 4 семестр 

курсовая работа - семестр 

 

 



  

№ 

п

/

п 

Тема и содержание 

Форма изучения материалов: лекции, 

практические занятия, семинарские 

занятия, лабораторные работы, 

самостоятельная работа и трудоемкость 

(в часах) 

Задания по самостоятельной 

работе студентов 

Форма текущего 

контроля 

успеваемости  

ЛК ПР/СЕМ ЛР СР 

1 2 3 4 5 6 8 9 

4 семестр  

1.  Тема 1.  Определение геоинформационных систем 

(ГИС). Понятие ГИС.  Их структура. Классификация 

ГИС: по назначению, по проблематической ориентации, 

по  территориальному охвату, по способу организации 

географических данных. Функциональные требования к 

ГИС: автоматизированное картографирование, 

пространственный анализ, управление данными.  

Применение ГИС в научных исследованиях. 

Компьютерные технические средства и устройства 

поддержки ГИС. Программное обеспечение: системное, 

базовое и прикладное. История развития ГИС. 

 

Лабораторная работа № 1. Определение 

морфометрических, ландшафтных и гидрографических 

характеристик речного водосбора.  

Лабораторная работа № 2. Основы работы с 

пространственными данными (визуализация). Создание 

климатической карты мира. 

2 - 6 5 Подготовка к защите лабораторных 

работ  

 

Подготовка к рубежным 

контрольным работам  

 

Подготовка к зачету 

Лабораторные работы  

 

 

Контрольные работы 

 

 

Зачет 

2.  Тема 2.  Общие представления о 

гидрометеорологической информационной системе: 
специфика гидрометеорологической информационной 

системы (ИС), задачи гидрометеорологической ИС, 

требования к техническим средствам, 

поддерживающим гидрометеорологические ИС. 

 

Лабораторная работа № 3. Анализ гидрографических 

сетей.  

Лабораторная работа № 4.  Анализ цифровой модели 

рельефа.  

2 - 6 5 Подготовка к защите лабораторных 

работ  

 

Подготовка к рубежным 

контрольным работам  

 

Подготовка к зачету 

Лабораторные работы  

 

 

Контрольные работы 

 

 

Зачет 

3.  Тема 3. Организация баз данных в 

гидрометеорологических ИС. 

2 - 6 5 Подготовка к защите лабораторных 

работ  

Лабораторные работы  

 



  

Гидрометеорологические данные: синоптическая 

информация, аэрологические данные, океанологическая 

и гидрологическая съемки, данные спутникового 

мониторинга атмосферы и гидросферы и т.д. Ввод 

данных в ГИС. 

Организация баз гидрометеорологических данных: 

географические сведения, морфология, 

гидрометеорологическая информация. 

 

Лабораторная работа № 5. Привязка и цифрование 

гидрогеологической карты. 

Лабораторная работа № 6. Пространственная 

интерполяция характеристик годового стока с 

использованием ГИС-технологий.  

 

Подготовка к рубежным 

контрольным работам  

 

Подготовка к зачету 

 

Контрольные работы 

 

 

Зачет 

4.  Тема 4. Обработка гидрометеорологических 

данных. Расчет статистической информации. Методы 

восстановления гидрометеорологических полей: 

оптимальная интерполяция, метод взвешенных 

коэффициентов, сплайн-интерполяция и др. 

Редактирование и обновление базы данных (БД). Расчет 

дополнительных параметров по этим данным. 

 

Лабораторная работа № 7. Расчет характеристик 

годового стока на основе интерполяционных карт.  

Лабораторная работа № 8 Оценка плотности 

распределения.  

2 - 4 5 Подготовка к защите лабораторных 

работ  

 

Подготовка к рубежным 

контрольным работам  

 

Подготовка к зачету 

Лабораторные работы  

 

 

Контрольные работы 

 

 

Зачет 

5.  Тема 5. Вывод и визуализация данных. Технические 

средства. Методы визуализации данных: растровая и 

векторная графика. Особенности создания 

компьютерных гидрометеорологических карт и атласов. 

Отображение пространственно-временных 

гидрометеорологических характеристик. 

 

 

Лабораторная работа № 9. Пространственная 

интерполяция.  

2 - 2 5 Подготовка к защите лабораторных 

работ  

 

Подготовка к рубежным 

контрольным работам  

 

Подготовка к зачету 

Лабораторные работы  

 

 

Контрольные работы 

 

 

Зачет 

6.  Тема 6. Особенности применения математического 

моделирования в гидрометеорологических ИС. 
Информационное единство динамической модели и 

4 - 2 6,8 Подготовка к защите лабораторных 

работ  

 

Лабораторные работы  

 

 



  

измерений. Адаптация модели к исходным данным. 

Мультимедийная визуализация результатов 

моделирования. Имитационное моделирование. 

 

Лабораторная работа № 10. Трехмерное 

моделирование. 

Подготовка к рубежным 

контрольным работам  

 

Подготовка к зачету 

Контрольные работы 

 

 

Зачет 

 Всего часов по 4 семестру: 14 - 26 31,8   

5 семестр 

1.  Тема 1. Оптимизация гидрометеорологических ИС. 
Критерии качества: простота вычислительного 

алгоритма, минимальная стоимость затрат на 

проведение натуральных экспериментов и т.д. 

 

Лабораторная работа № 1. Привязка растров по 

координатам в программе ArcGis. 

4 - 4 2 Подготовка к защите лабораторных 

работ  

 

Подготовка к рубежным 

контрольным работам  

 

Подготовка к з экзамену 

Лабораторные работы  

 

 

Контрольные работы 

 

 

Экзамен 

2.  Тема 2. Средства доступа к 

гидрометеорологическим базам данных. Работа с 

гидрометеорологическими данными при помощи 

приложений: «сервера», представляющего данные из 

общей базы данных, и «клиента», запрашивающего 

данные у «сервера». 

 

Лабораторная работа № 2. Создание shp-файлов в 

программе ArcGis. 

4 - 6 2 Подготовка к защите лабораторных 

работ  

 

Подготовка к рубежным 

контрольным работам  

 

Подготовка к з экзамену 

Лабораторные работы  

 

 

Контрольные работы 

 

 

Экзамен 

3.  Тема 3. Приложение «сервер»: режимы 

функционирования, структура размещения ресурсов, 

настройки «сервера», форматы системных журналов, 

взаимосвязь между настройками «сервера» и 

настройками ядра операционной системы, организация 

корпоративных данных из БД. 

 

Лабораторная работа № 3. Заполнение атрибутивной 

таблицы в программе ArcGis. 

Лабораторная работа № 4. Применение некоторых 

инструментов модуля Arcgis Spatial Analyst в 

программе ArcGis. 

2 - 8 2 Подготовка к защите лабораторных 

работ  

 

Подготовка к рубежным 

контрольным работам  

 

Подготовка к з экзамену 

Лабораторные работы  

 

 

Контрольные работы 

 

 

Экзамен 

4.  Тема 4. Приложение «клиент»: одновременный 

доступ к нескольким серверам, одновременный доступ 

внутри одного «сервера» к нескольким базам данных. 

2 - 4 2 Подготовка к защите лабораторных 

работ  

 

Лабораторные работы  

 

 



  

 

 

 

 

Лабораторная работа № 5. Создание диаграмм в 

программе ArcGis. 

Подготовка к рубежным 

контрольным работам  

 

Подготовка к з экзамену 

Контрольные работы 

 

 

Экзамен 

5.  Тема 5. Особенности гидрометеорологических ИС 

для Интернет. Возможности, предоставляемые 

пользователям ГИС для Интернет. 

 

Лабораторная работа № 6. Создание карты режима 

увлажнения Республики Башкортостан в программе 

ArcGis. 

2 - 4 4 Подготовка к защите лабораторных 

работ  

 

Подготовка к рубежным 

контрольным работам  

 

Подготовка к з экзамену 

Лабораторные работы  

 

 

Контрольные работы 

 

 

Экзамен 

6.  Тема 6. Проблемы безопасности в 

гидрометеорологических ИС. Контроль прав доступа. 

Контроль регистрационных журналов. Фильтрация 

пакетов. Резервное копирование и восстановление 

данных. Шифрование данных. 

 

Лабораторная работа № 7. Создание карты ИЗА по г. 

Уфа Республики Башкортостан в программе ArcGis. 

2 - 4 4 Подготовка к защите лабораторных 

работ  

 

Подготовка к рубежным 

контрольным работам  

 

Подготовка к з экзамену 

Лабораторные работы  

 

 

Контрольные работы 

 

 

Экзамен 

7.  Тема 7. Обзор современных 

гидрометеорологических ИС. Обзор современных 

гидрометеорологических информационных систем. 

Основные компоненты. Приложения. 

Телекоммуникация. Основные принципы работы. 

Региональные гидрометеорологические ИС. 

 

Лабораторная работа № 8. Выделение водосборных 

бассейнов по ЦМР. Определение некоторых 

гидрографических характеристик водосборов и 

водотоков по ЦМР в программе ArcGis. 

2 - 4 4 Подготовка к защите лабораторных 

работ  

 

Подготовка к рубежным 

контрольным работам  

 

Подготовка к з экзамену 

Лабораторные работы  

 

 

Контрольные работы 

 

 

Экзамен 

 Всего часов по 5 семестру: 18 - 34 20   

 Всего часов: 32 - 60 51,8   



 


